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Let me pick on the 
"Quicken" program.  
This is not to imply that the manufac-
turers of Quicken are doing anything 
that many other software manufactur-
ers don't do.  The core Quicken      
program is a very stable functional   
program that I believe everyone should 
have.  Here's the problem: Quicken 
can only sell for so much because of 
competition.  So after you get all the 
bugs out of the program, which with a 
relatively simple program like Quicken 
that has literally hundreds of thou-
sands of users pounding away on it, 
does not take too long, what do you 
have left to do?  At this point there is 
little to no more potential new market. 
 
Now you have a program, a product 
that's saturated it's market, it's bug free 
(well as bug free as any software pro-
gram can be), and covers all the func-
tionality 99.9% of the users' need.  So 
what do you do?  Shut down the com-
pany and disband it?  Of course not. 
You create a new version!  But what 
can you do to get people to buy it?  
You can't tell people that the program 
they bought last time, which you said 
was so wonderful, is junk.  You have to 
convince the people that the new ver-
sion is head and shoulders better that 
the version they current use; you know, 
the version with virtually no bugs that 
does everything they really need to do. 

(Continued on page 5) 

H ey, it's SPRING!  Everyone 
I've talked with is focused on 
Spring.  Those Dandelions 

are starting to pop out.  Spring is    
always an improvement over winter.   
 
I wish everyone understood the con-
cept of improvement.  It seems to me 
the manufacturers of most software 
programs don't understand the con-
cept of improvement.  They certainly 
understand the concept that if they can 
convince you via enough pain with the 
current version they can force you to 
'rev up,' or if they can make the new 
version appear attractive enough they 
can entice you to 'rev up'.  The concept 
is that no matter what the reason is, if 
you 'rev up' the software manufacturer 
has money coming into their coffers. 
 
It's my opinion that many software 
manufacturer no longer make new ver-
sions to offer a better product.  They 
seem to generally offer a new version 
for the sole reason of being able to sell 
you another version and fixing bugs 
which they should have fixed during 
testing of the original version.  Clearly 
many new versions have new features. 
However, new features for the purpose 
of getting you to 'rev up' aren't neces-
sarily good and / or required features.  
It seems to me that a continual stream 
of new versions for a particular soft-
ware package is software licensing in 
disguise. 

          The President’s Pen  
                 by Don VanSyckel 
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Unless stated otherwise, all materials contained in this newsletter are copyrighted 
by the Sterling Heights Computer Club. License is hereby granted to other clubs 
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SIG  Meetings 

Net/Com  SIG  
 

T he next 
meeting of 
the Inter-

n e t / C o m m u n i -
c a t i o n s  ( N e t /
Comm.) SIG will be 
Monday,  May 10, 
2004, starting at 

7:00PM, at the Macomb County 
Library. The SIG meeting days are   
generally the second Monday of the 
month.  
 
Each month the members of the Net/
Comm SIG discuss the Internet to help 
members of the SHCC learn more 
about this communications media. 
This month, the topic will be 
“Interesting Web Sites For Everyone”. 
 
For more information about the SIG, 
call or e-mail Betty MacKenzie 
(numbers are on page 2), or check the 
club web site. 

� � � � � 

� � � � � 

 Directions To The      
Macomb Library 

 

T he Macomb County Library is 
located at 16480 Hall Road, in 
Clinton Township, between 

Hayes and Garfield, close to the light 
at Garfield, on the south side of Hall 
Road. A large red sign says “Macomb 
County Library”. The phone number  
is  (586) 286-6660. 

� � � � � 

SHCC Emergency 
Shutdown 

 

T he Sterling Heights Computer 
Club will utilize radio station 
WWJ - 950 on the AM dial to 

notify members that a meeting is 
canceled because of bad weather or for 
other reasons.  The announcement 
will happen along with the school 
closings and other events.  Please 
remember to listen to the radio when 
there is bad weather. 

� � � � � 

PC SIG 
 

T h e  n e x t 
meeting of 
the PC SIG is 

Wednesday, May 26, 
2004. The SIG meet-
ing is generally the 

last Wednesday of the month. 
 
Intermediate level topics are discussed, 
aimed at users with some knowledge of 
computers. During this meeting, ques-
tions and answers regarding your com-
puter will be discussed, and there will be 
some surprises. The topic for this 
month will be, “How To Create Playlists 
And CD's Using Music Match Juke-
box.” 
 
For more information about the SIG,  
call or e-mail Jack Vander-Shrier  
(numbers are on page 2), or check the 
club web site. 

Attend  A  SIG 
 

I f you do not attend SIG meetings, 
you are missing out on important 
club benefits available to you. 

These small groups get into more detail 
and question and answer sessions than 
is possible at the main meeting. 

� � � � � 

Novice  SIG 
 

T h e  n e x t 
meeting of 
the  Novice 

SIG will be Monday, 
May 17 2004, starting 
at 7:00PM, at the 
Macomb County 

Library. The SIG meeting days are gen-
erally the third Monday of the month.  
 
A little more than half of the people 
attending the SIG use Windows 98 so 
the actual presentations will be done 
on Win98.  The beginning concepts 
are applicable to WinME and WinXP 
directly.  As we progress through the 
year and get to more advanced Novice 
topics a few items will vary between the 
different Windows versions, but we'll 
cover those differences at that time.   

There is always a question and answer 
period at these meetings.  
 
The computer training sessions are free 
to club members, but  members will be 
advised to purchase the book in use by 
the class. 
 
For more information about the SIG, 
call or e-mail Don VanSyckel (numbers 
are on page 2), or check the club web 
site. 

� � � � � 

� � � � � 

Door Prizes 
 

T he SHCC offers door prizes at 
most regularly scheduled club 
meetings. The door prizes for  

the May meeting were not known at 
the time of publication. 
 
April’s  coveted winner’s circle in-
cluded: 
 
Lil Contrera, Adriana Cuevas, 
Jack Voyles, Jane Minnick, Don 
Hjelle all won  CD cases w/disks 
 
Emmy Evangelista won a Microsoft 
Office Evaluation Kit 
 
Russ Canary won a Microsoft     One-
note Evaluation Kit 
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SHCC  Business  

Please send questions to 
“Ask the Experts” at the 
club’s PO address, or e-mail your 
question directly to the Expert at the 
club e-mail address: AskTheEx-
pert@SterlingHeightsComputerClub.
org. 

“Ask The Experts” 
by Jack Vander-Schrier 

New SHCC Members 
Please welcome the following new members: 

       
Padraic (Paddy) Mullin — spelling correction from April 

Q : Dear Expert: 
 
I'm always worried about     

loosing all those precious messages and 
addresses in my Outlook Express.  Is 
there an easy way that I can back up 
my Outlook Express and Address 
books and even my mail settings? 
 
Signed 
Wanting to Backup 
 
 

A : Dear Wanting to Backup: 
Its always important to back 
up the files that are near and 

dear to you.  One of the hardest things 
to back up is your mail and address 
book, unless you know the easy way.   
Here is the easiest way to do it. 
 
Copy Mail Files to a Backup Folder 
To make a backup copy of your Out-
look Express e-mail message files: 
  1.. On the Tools menu, click         
Options. 
  2.. On the Maintenance tab, click 
Store Folder. 
  3.. Select the folder location, and 
then press CTRL+C to copy the loca-
tion. 
  4.. Click Cancel, and then click Can-
cel again to close the dialog box. 
  5.. Click Start, and then click Run. 
  6.. In the Open box, press CTRL+V, 
and then click OK. 
  7.. On the Edit menu, click Select 
All. 
  8.. On the Edit menu, click Copy, 
and then close the window. 

  9.. Right-click any empty space on 
your desktop, click New, and then 
click Folder. 
  10.. Type mail backup for the folder 
name, and then press ENTER. 
  11.. Double-click the Mail Backup 
folder to open it. 
  12.. On the Edit menu, click Paste. 
  13.. Close the Mail Backup window. 
Export the Address Book to a File 
 
NOTE: This step is very important 
when multiple Identities are in use. 
A  .WAB (Windows Address Book) file 
is used by Outlook Express 5.x and 6.0 
versions, even if multiple Identities are 
used. The individual data for each 
Identity is stored in a folder, by user 
name, within the .WAB file in use. 
 
Exporting this data, while logged in to 
a specific Identity, is the only means of 
segregating the Address Book data. If 
the .WAB file becomes dissociated 
from the user Identities, the data can 
only be exported in total - not folder by 
folder. 
 
Another reason to export the .WAB 
file to a .csv file is that if the .WAB file 
is shared with Microsoft Outlook, the 
addresses are stored in the *.pst file in 
Outlook. When you export the file 
from the Outlook Express File menu 
to a *.csv file it exports the correct con-

tacts. If the Address Book is shared 
with Microsoft Outlook, you are not 
able to export from within the Address 
Book on the File menu. This option is 
dimmed or not available. 
 
To export your Outlook Express    
address book: 
  1.. On the File menu, click Export, 
and then click Address Book. 
  2.. Click Text File (Comma Separated 
Values), and then click Export. 
  3.. Click Browse. 
  4.. Locate the Mail Backup folder that 
you created. 
  5.. In the File Name box, type address 
book backup, and then click Save. 
  6.. Click Next. 
  7.. Click to select the check boxes for 
the fields that you want to export, and 
then click Finish. 
  8.. Click OK and then click Close. 
 
Export the Mail Account to a File 
To make a backup copy of your Out-
look Express mail account: 
  1.. On the Tools menu, click Ac-
counts. 
  2.. On the Mail tab, click the mail 
account that you want to export, and 
then click Export. 
  3.. In the Save In box, locate the Mail 
Backup folder on your desktop, and 
then click Save. 
  4.. Repeat these steps for each mail 



Page  5 

                      THE WYSIWYG                                                                                                             May  2004 

(Continued from page 1) 
Then to compound injury to insult, 
many times the software manufacturers 
tweak things that were working very 
well, simply (it seems to me) to be able 
to say it's changed in the list of reasons 
for buying the new version.  Well I'm 
tired of being the financial punching 
bag and cash cow of software compa-
nies.  I get extremely frustrated with 
software manufacturers who have a 
good product and mess it up just so 
they can make changes in order to sell 
a new version. 
 
I have a revelation for the manufac-
turer of Quicken: my checkbook bal-
ance has exactly the same low balance 
no matter what version of your prod-
uct I use.  If they can write good soft-
ware like Quicken, pick another area 
of everyday household life and write a 
program to help me save time and do 
it better.  I'm done buying new ver-
sions to add 2 plus 2, when every sin-
gle version tells me 4 is the answer. 
 
The second example is Broderbund 
Family Lawyer 2004.  I have a couple 
older versions.  I believe Broderbund 
bought this from Parsons Technology.  
Anyway, I bought the new version with 
the idea that some laws could have 
changed and the current package 

� � � � � 

The President’s Pen 

� � � � � 

account that you want to export. 
  5.. Click Close. 
 
Now that you have this information in 
your Mail Backup folder - just burn 
your Mail Backup folder to a CD and 
you’re in business.  DON’T EVEN 
TRY to save it to a floppy Disk. 
 
Importing Outlook Express data 
To restore data, you may need to        
re-create the Identities for each user, 
prior to using the following steps.   
Repeat each step, as needed, for each 
Identity. 
 
Import Messages from the Backup 
Folder 
To import your Outlook Express        
e-mail messages from the Backup 
folder: 
  1.. On the File menu, point to Im-
port, and then click Messages. 
  2.. In the Select an e-mail program to 
import from box, click Microsoft Out-
look Express 5 or Microsoft Outlook 
Express 6, and then click Next. 
  3.. Click Import mail from an OE5 
store directory or Import mail from an 
OE6 store directory, and then click 
OK. 
  4.. Click Browse, and then click on 
the Mail Backup folder on your desk-
top. 
  5.. Click OK, and then click Next. 
  6.. Click All folders, click Next, and 
then click Finish.  
 
Import the Address Book File  
To import your Outlook Express ad-
dress book: 
  1.. On the File menu, click Import, 
and then click Other Address Book. 
  2.. Click Text File (Comma Separated 
Values), and then click Import. 
  3.. Click Browse. 
  4.. Locate the Mail Backup folder on 
your desktop, click the address book 
Backup.csv file, and then click Open. 
  5.. Click Next, and then click Finish. 
  6.. Click OK, and then click Close. 
 
Import the Mail Account File 
To import your Outlook Express mail 

account file: 
  1.. On the Tools menu, click Ac-
counts. 
  2.. On the Mail tab, click Import. 
  3.. In the Look In box, locate the 
Mail Backup folder on your desktop. 
  4.. Click the mail account that you 
want to import, and then click Open. 
  5.. Repeat these steps for each mail 
account that you want to import. 
  6.. Click Close. 
 
Hope that helps 
Jack 

would have all of those type details up 
to date.  I did not buy the new version 
because there was anything wrong with 
the program or functional part of the 
version I have.  Well it's the last 
Broderbund product I'll ever buy.  
They have taken a perfectly easy to use 
program (the last Parson's version I 
have) and twisted it to the point where 
it's totally unusable and user un-
friendly.  It only took ten minutes to 
see that this program is nothing I want 
to spend any time on.  If we could find 
out the "real  reason" for the changes, 
I'd bet we'd find that the changes were 
made to sell another version.  As usual 
I was a little slow in getting around to 
loading the new version or I would 
have returned it the very day I loaded 
it.  I did uninstall it and will check 
about returning it. 
 
The bottom line of my message is       
a) the new versions of software are not 
necessarily better than the version you 
have, b) carefully read the info about 
the new version to determine if it really 
does anything for you before you buy 
it, and c) complain if a software manu-
facture tells you that to 'fix' the broken 
feature in the version you have, you 
need to 'rev up'. 
 
This month we were not able to      
arrange for a company to do a presen-
tation.  If anyone has something they 
would like to share with the group con-
tact me.  If no one volunteers I will 
present information about what's hap-
pening with the WYSIWYG Web 
Watch (WWW) pages.  I've mentioned 
in the past how valuable I think the 
WWW column is.  I believe the      
enhancements currently be made to 
the WWW column web pages on our 
web site makes this information easier 
to use and more accessible. 
 
I hope to see you Tuesday.  Bring 
along a question or two if you have any 
and bring along a friend or two if you 
have any, and they'll thank you. 
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I  have heard about road rage for 
years and have even seen instances 
of it. For some people just putting 

them behind a steering wheel gives 
them an angry feeling toward all other 
drivers on the road. 
 
I am seeing a similar reaction with 
some people as soon as they are in 
front of a computer keyboard. 
Suddenly they are no longer 
reasonable, rational people using the 
computer to make their life better. 
They react as put-upon individuals that 
are using a tool, which they would 
rather not use, can’t really see the 
benefit in using it, would rather be 
doing anything else other than sitting 
there in front of their computer, and 
they do not want to learn anything 
about their computer other than how 
to use the applications that they have 
been forced to use because of outside 
pressure. They act as if it is an 
imposition to have to learn anything 
more about their computer than how 
to turn it on. They see no useful value 
in understanding any of the workings 
of the computer. They have much 
more valuable use for their time than 
to spend any of it learning useless (in 
their estimation) information. 
 
Unfortunately, not only do we have 
the “Computer Rage” group that think 
it is chic to hide behind their rage with 
an “I would rather work harder, than 
smarter” attitude, there are others. 
Some groups that come to mind are 
the 1 am too old to learn this 
computer stuff” the “I am too dumb to 
learn this computer stuff,” the “I am so 
computer illiterate that I don’t even 
know how to turn one on, and proud 
of it,” and the “I would probably do 
something wrong and break it” group. 
 
What could be some of the reasons for 
these attitudes, reactions or myths to 
using a computer? 

Computer Rage 
by Elise M. Edgell and Jim Sanders, North Orange County Computer Club 

One reason is that computer software 
and hardware companies have fostered 
the idea that in today’s world 
computers are so sophisticated that 
they can be run without any necessity 
for the user to learn the basics. As an 
example, the Windows operating 
system installs with many of its defaults 
set to “protect” the user from much of 
the really useful information that is 
needed for intelligent operation of the 
computer. The problem with that is, if 
the information is hidden, the user 
may  be  un aware  o f  needed 
information. 
 
So why should you make the effort to 
learn more about your computer? Even 
if you are using a computer under 
duress (real or perceived) once a 
computer is an integral part of your 
personal or business life, it is very 
upsetting for the computer to be 
unavailable to perform the tasks that 
you’ve come to depend on. 
 
When a problem occurs with your 
program or with your hardware, 
instead of just feeling abused, put 
upon, frustrated, helpless, or mad, you 
wiII have some options if you learn 
some of the basics. You will he able to 
take care of some of the simple and 
common problems yourself. When you 
get the “Disk A: is write-protected” 
error message while trying to save a file 
to the floppy disk, you will know that 
all you have to do is take the floppy 
out of the drive, slide over the write-
protect tab to cover the hole, and re-
insert it in the drive. The problem was 
solved in ten seconds, no rage, no 
anger, no anxiety, actually, no real 
problem.  It was just one of those 
things that happen and have to be 
dealt with. 
 
Even if you can’t solve the situation on 
your own, you will be able to 
communicate the problem in 

understandable terms. This makes it 
possible for you to ask for help over 
the telephone, or even on the Internet. 
You’ll also need to know when you 
really need help and to know if the 
‘‘help’’ you are getting is valid. Last, 
and far from least, most windows have 
a ‘Help” menu, and there is always the 
“START’ button and general “HELP” 
option. But once again, if, for whatever 
reason, you have not bothered to learn 
some of the basic concepts and 
terminology, you won’t be able to ask 
the right question, or understand the 
answer if you stumble across it. 
 
I have also heard people say. “I watch 
TV but I don’t have to learn how it 
works, why should I have to learn how 
to use my computer?”  My response is 
that today’s computers place an 
unbelievable amount of access to 
information, knowledge, and creative 
programs at your fingertips.  For 
chump change (don’t know what that 
means-- look it up on Google.com) you 
can buy a nice computer and access to 
the Internet. As soon as you buy that 
combination you have an almost 
unimaginable power sitting on your 
desk.  Power that just a few years ago 
on l y  gove rnmen t s  and la rge 
corporations could afford. Once you 
are on the Internet, most of the 
information, a lot of the knowledge, 
and quite a few of the applications are 
free! You may have seen the TV ad 
showing a one man garage shop 
company that looks like a large 
company because of what the 
computer can do. This is a true story, 
not an advertiser’s pipe dream. 
Information is power and the Internet 
makes information available on about 
any subject. Aside from the “chump 
change,” what does all this power cost? 
The willingness to spend the time to 
learn how to use it! 
 
I am no longer envious of people who 
live near a large library. I use the 
Internet to answer many of the 
questions which I think about but 
forget before I get to a dictionary, 
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O ne of the biggest "panes" 
about Windows is that just 
about anything can break it -- 

such as installing a new program or 
getting rid of an old one. 
 
There’s a right way and a wrong way to 
do both -- but even if you do things the 
right way, you still can have problems. 
Windows 2000 and XP have better 
ways to recover than 98 but it’s still not 
a perfect world. That’s where the 
knowledge of one keystroke might be 
able to save your skin. 
 
One hidden setting in Windows 2000 
and XP (not in 98) also could help you, 
or someone from technical support, 
right the Windows ship. This one is 
turned off by default in those two ver-
sions of Windows but I’m going to tell 
you how to fix it.  
 
Here are the steps: 
 
* Right click on My Computer, then 
left click on Properties. 
* Click on the Advanced tab at the top 
of the next dialog box 
* Click on Settings in the startup and 
recovery section of the next dialog box. 
* Uncheck the box next to Automati-
cally restart under the System failure 
section. 
* Click OK twice. 
 

encyclopedia, or other paper research 
material. Now I can get an almost 
instantaneous answer and can ask to 
be notified by e-mail when a certain 
topic comes up in the news. For 
example I used this recently after I read 
a murder mystery based on a deadly 
chemical named sodium azide. I had 
never heard of it before. I searched the 
Internet using Google and found many 
articles about it and its deadly 
properties. This chemical is readily 
available and widely used. I was 
concerned enough to use a feature of 
Google to send me an e-mail when 
sodium azide is in a news story. 
 
Wouldn’t you be willing to invest some 
of your time to be able to really use 
this type of power? Whal about really 
learning some of the abilities of the 
software that is probably sitting on 
your computer? Have you ever really 
looked at the features of WordPad in 
Windows XP?  Have you ever clicked 
on help in WordPad? Did you know 
that the “Help Menu” in WordPad 
contains a “Help on how to use Help” 
section? Are you taking digital photos? 
Are you in sales? Do you have a 
disability? Of course you can find use 
for some of the more advanced 
features of your software. The problem 
is you won’t ever know what these may 
be, unless you expend some effort to 
learn what is possible. 
 
Once you decide that learning more 
about the potential of your computer 
is a benefit to you, it makes it a lot 
easier to find the time and energy to 
accomplish this. 
 
Understanding goes a long way toward 
the feeling of being in control. When 
you feel in control of your computing 
experience, the irrational feelings of 
rage will probably go away or at least be 
minimized. This doesn’t mean that you 
will no longer get mad or upset with 
your computer, far from it, just that 
you will be more likely do it for a real 
cause. 
 

How do you acquire the information 
and skills you need to feel in control of 
your computer?  One good way is to go 
to a computer user’ s  group. 
Unfortunately, if you are the person 
this article is about you are probably 
not getting this newsletter. My 
suggestion is that those of you who are 
getting this newsletter give a copy of 
this article to your friends that have 
computer rage. 

EliseME@aol.com 
 
The Editorial Committee of the 
Association of Personal Computer 
U s e r  G r ou p s  ( A P C U G ) ,  an 
international organization of which 
this group is a member, brings this 
article to you. 

Computers — From the Very Beginning 
by Charlie Paschal , Palmetto Personal Computer Club, Columbia, SC 

What does this do? Let me set up a 
scenario for you. You install an applica-
tion that corrupts (or changes) a file 
the system needs to run correctly. If 
the box above is checked, the system 
will automatically restart, showing a 
brief “blue screen” that doesn’t give 
you (or anyone else) a chance to see 
what the error is before Windows   
restarts again. It’s a vicious circle. 
 
With the above box unchecked, al-
though Windows still might not run, 
at least it will stop on the above blue 
screen, meaning you might be able to 
trace down the problem, perhaps    
replacing the needed file or get help 
from a more experienced technical   
support person who can identify the 
problem and talk you through fixing it. 
 
This is not a total solution but it gives 
you a fighting chance. With the above 
box checked, you don’t have a chance 
at all since you have no way of identify-
ing the problem. If you’re using Win-
dows XP or 2000, before you go to bed 
tonight, uncheck that box. By the way, 
Windows 2000 will make you restart 
your computer after hitting OK twice -- 
XP won’t. 
 
Another keystroke might get you out 
of an install mess. Sometimes with this 
one you have to be really quick because 
you have to hit it while Windows is 
starting up. With computers getting 
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VISIT THE SHCC WEB PAGE:  
http://www.
SterlingHeightsComputerClub.org 

� � � � � 

Member  Classified 
Ads 

 s end   any  classifieds  to the  
WYSIWYG   Publisher  at the 
club’s  PO  Box,  or  to  his   e-

mail address posted  on page 2 of the 
newsletter.  
 
Ads are available to SHCC members 
and are limited to computer related 
items for non-commercial purposes. 
There is no charge for members 
classified ads.  

Electronic WYSIWYG 
 

Y ou have the choice of receiving 
either the paper or the elec-
t ronic  ver s ion of  the 

WYSIWYG.  Contact the SHCC secre-
tary to  request the electronic version, 
since it will only be sent to those     
requesting it.   

� � � � � 

� � � � � 

Presenters Wanted 
 

T he officers invite any member 
to make a presentation at the 
main meeting. 

If there is some software you have been 
using and think others may be 
interested as well, or there is a 
computer topic you would like to 
present to other members, please call 
or e-mail Don VanSyckel. Making 
presentations is not that difficult.  The 
hour goes by before you know it and 
there is always enough material to 
cover in a software package so that the 
hour is easy to fill. 
 
If there is a topic you are interested in 
or something you would like 
demonstrated, please see any of the 
officers.  They are always interested in 
what the members would like to see.    

� � � � � 

faster and faster, you don’t have much 
time to hit this key because once Win-
dows starts loading the desktop, hitting 
this key won’t help. 
 
One of the ways to make sure you have 
time to hit the keys is to turn the com-
puter off completely, then get poised to 
hit the F8 key. It’s along the top row of 
keys of your keyboard and you MUST 
strike it before Windows starts loading 
the desktop. 
 
(With some computers this is made 
even harder by a flashy screen they dis-
play while in the background, Win-
dows is busy trying to load everything. 
Even if you get this type of screen once 
you hit the power button, hit F8 any-
way.) 
 
Sometimes you’ll get a message that 
you have a keyboard error and be 
asked to hit F1 to continue. If that 
happens, press F1, then F8 again. You 
should then get a menu in a DOS-like 
black screen. 
 
Let’s say that you install a program in 
Windows (any of the above three ver-
sions) and then you start getting error 
messages or, even worse, Windows 
won’t run at all. The one you want to 
choose is "Safe Mode." This is Win-
dows with all the good stuff removed. 
The operating system uses a minimum 
set of drivers and, to tell you the truth, 
it looks grimy because the display is 
using only 16 colors. I remember the 
days of 16 colors on monitors and they 
looked pretty good back then; now I’m 
spoiled with millions of colors.  
 
Once Windows loads, Windows 2000 
and 98 will look pretty much the same, 
except for the few colors. This is the 
time to go to the Control Panel, click 
on Add/Remove Programs and re-
move the program that started giving 
you the trouble in the first place. 
 
You also can go into Device Manager 
(right click on My Computer, then left 
click on Properties) to disable drives of 

devices you suspect are creating the 
problem. By clicking on the + sign next 
to a category, you can see the all the 
devices listed. Right clicking on the 
device will give you a context menu. 
On that menu is a "disable" device. 
That’s what you might want to do if 
that’s the one with the problem. 
 
While in this cocoon of safety, you can 
do such stuff as change video drivers, 
adjust video drivers or uninstall a pro-
gram that is creating problems. 
 
How to uninstall a program: 
 
* Open the Control Panel. 
* Double click on Add/Remove Pro-
grams. 
* Select the program you want to 
uninstall and follow the directions 
from the Wizard. 

In many cases, this will fix your com-
puter. If it doesn’t, at least you have a 
fighting chance by unchecking the 
automatic boot and learning how to 
use the startup menu that contains a 
goody that can help you rescue your 
system. 
 
Questions, comments to:  
Charlie@askcharlie.com. 
 
Charlie Paschal is a columnist for The 
(Columbia) State newspaper, SC 
 
The Editorial Committee of the Asso-
ciation of Personal Computer User 
Groups (APCUG), an international 
organization of which this group is a 
member. 
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 WYSIWYG WEB WATCH (www) 
By Paul Baecker 

webwatch@sterlingheightscomputer 
club.org 

 
This column 
attempts to lo-
cate sites con-
taining valuable, 
amusing and 
free content, 
with no over-
bearing pressure 

to purchase anything.  Send your favor-
ite (entertaining, helpful or just plain 
useless) sites, with brief site descrip-
tions, to the e-address noted above, for 
inclusion in a future WYSIWYG issue.  
Also check the SHCC web site (“Web 
Page Reviews”) for previous gems.   

Liquid Man.  He will follow your 
mouse.  Right-click to zoom in and 
out. 
http://www.neen.org/demo/clinger.
swf 
 
Amateur photos of the birth of hum-
mingbirds. 
ht tp://community -2 .webtv.net/
h o t m a i l . c o m / v e r l e 3 3 /
HummingBirdNest/ 
 
Run mouse over horsemen for unique 
animation. 
http://www.neen.org/demo/parade.
swf 
 
Illustrated instructions for building a 
portable alcohol stove for camping and 
similar activities. 
http://mywebpages.comcast.net/
p h o t o n s t o v e / s t o v e /
HighPerfAlcoholStove.html 
 
“Almost every file format in the 
world.”  Identifier for file extensions. 
h t t p : / / w w w . a c e . n e t . n z / t e c h /
TechFileFormat.html#nos 
 
Before you shell out big bucks for the 
Maytag Man, try your luck with the 

guides and wisdom of the Appliantol-
ogy Group. 
http://groups.msn.com/Appliantology 
 
Can't decide which candidate to vote 
for?  Searching for more information 
on a candidate?  Try this decision 
guide. 
http://www.presidentmatch.com 
 
Forgot a DOS syntax?  Here's a re-
fresher tool for DOS commands and 
usage examples. 
http://www.easydos.com/dosindex.
html 
 
What does your phone number spell? 
http://www.phonespell.org 
 
Visit the ruins of once-vibrant build-
ings of New England.  Select a site, and 
then click the previous/next buttons 
for additional photos. 
http://photos.dobi.nu 
 
How to totally defrag your harddrive. 
h t t p : / / w w w . d a t a d oc k t o r n . n u /
us_frag1.php 
 
Microwave tricks – renewing a dry 
erase marker. 
http://www.sunbelt-software.com/stu/
expo_vs_microwave.htm 
 
Multiple photo galleries of space from 
earth, and earth from space.  Hours of 
awe. 
http://www.space.com 
 
Annoying background images 
http://j-walk.com/other/annoying/
index.htm 
 
A free Windows tweak utility, X-Setup 
Pro.  Peruse the Features section to 
determine whether it is useful on your 
system. 
http://www.x-setup.net/product/
home.asp?lang=EN 
 � � � � � 

Bonds can be a good investment.  This 
BMA site offers tutorials and guides to 
help determine how and when to buy 
and sell. 
http://www.investinginbonds.com 
 
Are you using old anti-virus software?  
This quality a-v software publisher   
offers your PC a free virus check. 
http://housecall.trendmicro.com 
 
The International Edible Book Festival 
photo gallery.  Select “each year” and 
“photo albums” links for add’l delica-
cies. 
http://colophon.com/ediblebooks/
photos.html 
 
Sabotage!  “Joe Job” is a very crude 
form of identity theft.  Read about it 
here. 
http://www.sitepoint.com/article/
s a b o t a g e - c o p i n g - j o e - j o b / 1 ?
SID=b2234dcc72611e085acabff60d31
7e3c 
 
Symmetrical Line Inference – several 
colorful animated designs.  Fast PC 
recommended. 
http://www.permadi.com/flash/
recursivelines/ 
 
Among some financial programs avail-
able here is a free downloadable Retire-
ment Calculator – how much do you 
need to have and how long might it 
last? 
http://www.americanriver.com 
 
The unsinkable tugboat. 
http://www.netcopspsi.com/temp/
towboat.htm 
 
A peek into the handbags of over 40 
women, exposing the contents to see 
what’s really important.  Also takes a 
look at a few male backpacks. 
http://www.bagladies.nl 
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